

NAFED
A Farmer’s Cooperative
…Since 1958
e-Tender notice for supply of new light weight 775 gms Jute sacking bags for packing of Mustard Seeds (50 kg packing)
NAFED invites e-Tender from reputed Manufacturers/Millers or Authorized distributor/ dealer or traders of Jute bags for supply of new light weight sacking Jute bags 775 gms for packing 50 kgs Mustard Seeds as per BIS Specification No. IS 18161:2023 amended up to date (91 cms * 67.50 cms, Weight 775 gms)for onward despatch to various State Civil Supply Corporation/State Level Agency etc. Eligible bidders satisfying the Eligibility Criteria can participate in the e-Tender for supply of Gunny Bags.
Eligible Manufacturers/Millers or Authorized distributor/ dealer or traders of Jute bags can submit their bids till 21.01.2025 up to 02:00 PM at MSTC website. e-Tender finalization date along with date and time for matching the L-1 rates will be informed through e-mail communication wherein tenderers will be provided a fixed time window to provide their confirmation on the L-1 rates to be eligible for consideration for supply of Jute bags.

e-Tender terms & conditions can be downloaded from NAFED website as well as M/s. MSTC portal on payment Rs. 5900/- per form (Rs.5000/-+ GST @ 18 %) . Eligible Bidders can download the e-Tender terms & conditions from NAFED website www.nafed-india.com/tenders or MSTC portal https://www.mstcecommerce.com/eproc/. The e-Tender fees (non-refundable) of 5900 INR, (Five Thousand Nine Hundred only) which is inclusive of  GST @ 18% by means of DD/ Pay Order / NEFT / RTGS  has to be made in favour M/s. NAFED before submitting their bids in the e-Tender. Eligible bidders have to pay the tender fee on or before the last date of submission of bids otherwise it shall be treated as rejected. Further EMD amount of Rs.20,00,000.00 (Rs. Twenty Lakhs Only) in the form of NEFT/RTGS in the Bank Account of NAFED should be submitted at the time of submission of e-Tender. No adjustment will be made against previously submitted EMD. MSME will be exempted from tender fee and EMD on submission of the documents in this regard i.e., Valid MSME Udyam certificate. However, MSME bidders will have to deposit security deposit amount of 10% of total contract value (adjusting with the EMD deposit amount, if any) & Non-MSME will have to deposit security deposit amount of 10% of total contract value adjusting with the EMD deposit amount when they are awarded order for supply of gunny bags.



State Head
NAFED, Kolkata
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1. SCHEDULE OF TENDER (SOT): 
	a.
	MODE OF TENDER
	E Tender no.: ________________
e-tender System by Online Part I - Techno- Commercial Bid and Online Part II - Price Bid throughhttps://www.mstcecommerce.com/eproc/

	b.
	Notice available for parties to view
	From 15.01.25 onwards	

	c.
	Last date and time of remittance of Tender Fee 
	
21.01.25 up to 02:00 PM

	d.
	Pre-Bid meeting
	On 17.01.2025 at 12 noon at Kolkata branch office

	e.
	Last Date for deposition/ Remittance of EMD amount
	
21.01.25 up to 02:00 PM

	f.
	Start date and time of submission of online Techno-Commercial Bid and price	 Bid at https://www.mstcecommerce.com/eproc/
	
15.01.25 at 02:00 PM onwards

	g.
	Last date and time of submission of online Techno-Commercial Bid and price Bid	at https://www.mstcecommerce.com/eproc/
	
 21.01.25 up to 02:00 PM

	h.
	Matching with L1 rates through e-mail communication or reverse auction.
	
To be communicated later










2. Important instructions for e-procurement 
Bidders are requested to read the terms & conditions of this tender before submitting their online tender.
1.	Process of E-tender:
A) Registration: The process involves vendor’s registration with MSTC e-procurement portal which is free of cost. Only after registration, the vendor(s) can submit his/their bids electronically. This submission of bids shall be done over the internet. The Vendor should possess a valid Class III signing and encryption type digital signature certificate. Vendors are to make their own arrangement for bidding from a computer connected with Internet. MSTC is not responsible for making such arrangement. (Bids will not be recorded without Digital Signature).
SPECIAL NOTE: THE PRICE BID HAVE TO BE SUBMITTED ON-LINE ATwww.mstcecommerce.com/eproc
i. Vendors are required to register themselves online with https://www.mstcecommerce.com/eproc → Register (Filling up details and creating own user id and password) → Submit. Please follow the ‘Registration Guide’ available in the Registration link before proceeding.
ii. Vendors will receive a system generated mail confirming the registration in their email which has been provided during filling the registration form.
iii. The Vendors shall have to subscribe to the buyers and categories in order to receive system generated mails. In order to subscribe, a vendor has to login and click on ‘My Subscription’ followed by ‘Add Subscription’. On successful subscription, a system generated mail shall be forwarded to the vendor. Please follow the guide for ‘Subscription’ of ‘Download Guides’ available in the Dashboard before proceeding.
For specific queries/ clarifications, please contact MSTC
Contact person (MSTC Ltd):
HELPDESK Numberfor any technical assistance– 033 23400020/21/22, 033   35013220/21/22
1. Mr. Sabyasachi Mukherjee, Manager, ERO, Mobile No. 7278030407 email: smukherjee@mstcindia.co.in
2. Mr. K Kranthi Kumar , Asst. Manager, ERO, Mobile No: 9174009882,  email :kkkumar@mstcindia.co.in
B. System Requirement:
a) Operating System –Windows 7 and above 
b) Web Browser- Preferred ‘IE 8’ and above. 
c) Security Settings:  
i) Tools=>Internet Options=>Security=>Disable protected Mode If enabled-i.e., Remove the tick from the box mentioning “Enable Protected Mode”. 
ii) Tools => Internet Options => Security =>Custom Level=>
· Active X control & plug-ins: Enable all Active-X Controls  
· Scripting: Enable “Allow Status Bar Update Via Script”
· Disable “Use Pop-up Blocker” 
 d) Java: JRE 8 Latest update 
e) Other Settings: 
i) View => Toolbars=> “Tick” Status Bar. 
ii) Tools=>Internet Options=> General=> Click on Settings under “Browsing history/Delete Browsing History”=> Temporary Internet Files=>Activate “Every time I Visit the Webpage”. 
f) For new Version of IE or other “Active –X Filtering” under Tools should not be ticked. 
g) Tools =>Internet Options=> Security=> Selected Trusted Sites=> Add Website http://www.mstcecommerce.com. 
2.	The tender will be opened electronically on specified date and time as given in the NIT.
3.	All entries in the tender should be entered in online Price Bid Formats without any ambiguity.
4.	All notices and correspondence to the bidder(s) shall be sent by email only during the process, up to the finalization of tender by MSTC. Hence the bidders are required to ensure that their official emailID provided is valid and updated at the stage of registration of vendor with MSTC (i.e. Service Provider). Bidders are also requested to ensure validity of their DSCs (Digital Signature Certificates).
5. E-tender cannot be accessed after the due date and time.
6. Bidding in e-tender:
a. The process involves Electronic Bidding for submission of Bid.
b. The bidder(s) can submit their Bid through internet in MSTC Website www.mstcecommerce.com/eproc
c. The NIT/ Documents shall be available for download in the event catalogue available under ‘Event Details’ of the Event.
d. Please follow the guides for ‘Uploading encryption public key’ and ‘Bidding’ under ‘Download Guides’ available in the Dashboard before proceeding to submit bid.
e. The bidders may upload the bidding related documents in the link ‘My Documents’. The documents uploaded here shall be available for attaching with this event in the Bid Floor.
f. In order to submit bid, a vendor has to go to ‘Events’ from the menu and select ‘Bid Floor’. The vendor has to select the buyer ‘MSTC Limited’ from the buyer list in order to view the live events list.  The correct event has to be selected from the event list for participation. A vendor has to submit ‘Event wise bid details’ that may consist of ‘Pre-Qualification Criteria’, ‘Common Terms’ and/ or ‘Document Attach’. A vendor has to save the Pre-Qualification Criteria, Common Terms and/ or attach documents by clicking the respective buttons. Once the event specific bids are saved, the status is updated in ‘Event specific bid status’ and the ‘Item specific bid’ button appears on the bid floor. Thereafter vendor has to click button under ‘Technical Cover’ in order to save the technical bid for specific lots. Once the technical bid is saved, the ‘Price Cover’ button appears on the screen for respective lots. Once price bid is saved, the vendor has to click on ‘Final Submit’. On final submission of bid, the status of the bid submission shall display ‘Bid submitted’ under ‘Item specific bid status’. A vendor shall receive system generated mail. 
NOTE: - The bid cannot be revised once the Final Submit button has been clicked by the bidder. However, if the bidder wishes to change his bids, then he may delete the bid and re- submit the same.
g. In all cases, bidder should use their own ID and Password along with Digital Signature at the time of submission of their bid.
h. During the entire e-tender process, the bidders will remain completely anonymous to one another and also to everybody else.
i. The e-tender floor shall remain open from the pre-announced date & time and for the duration mentioned above.
j. All electronic bids submitted during the e-tender process shall be legally binding on thebidder. Any bid will be considered as the valid bid offered by that bidder and acceptance of the same by MSTC Ltd will form a binding contract between MSTC Ltd and the Bidder.
k. 	It is mandatory that all the bids are submitted with digital signature certificate otherwise the same will not be accepted by the system.
l. MSTC Ltd reserves the right to cancel or reject or accept or withdraw or extend the tender in full or part as the case may be without assigning any reason thereof.
No deviation of the terms and conditions of the tender document is acceptable. Submission of bid in the e-tender floor by any bidder confirms his acceptance of terms & conditions for the tender.
m. Unit of Measure (UOM)is indicated in the e-tender Floor. Rate to be quoted should be in Indian Rupee as per UOM indicated in the e-tender floor/tender document.
7.	Any order resulting from this e-tender shall be governed by the terms and conditions mentioned therein.
8.	No deviation to the terms & conditions are allowed.
9.	MSTC Ltd has the right to cancel this e-tender or extend the due date of receipt of bid(s) without assigning any reason thereof.
10.	The online tender should be submitted strictly as per the terms and conditions and procedures laid down in the website www.mstcecommerce.com/eprochome/mstc of MSTC Ltd.
11	The bidders should upload all the documents required (if any) as per terms of NIT. Any other document uploaded which is not required as per the terms of the NIT shall not be considered.
12.	The bid will be evaluated based on the filled-in Price bid formats.
13.	Canvassing in any form in connection with the Tender is strictly prohibited and the bids submitted by the bidders who resort to canvassing are liable to be rejected.
14. The bid will be evaluated based on the filled-in technical & commercial formats. All the L1 Bid/Bids received against any lot shall be considered irrespective of the “Best Deal” tag displayed in the system.
Only those Bidders who are found to be eligible in accordance with the prescribed eligibility conditions and whose bids meet the requirements under this Tender Document shall be declared as the “Technically eligible Bidders”.

The Lowest price offer amongst the Technically eligible Bidders shall be the floor price for the reverse e-auction.
The Technically eligible Bidders shall be ranked on the basis of the ascending price bid offer submitted by them. On the basis of such ranking the Technically eligible Bidders, holding first fifty per cent of the ranks (with any fraction rounded off to higher integer) or the top five Technically eligible Bidders, whichever is higher, shall be considered to be qualified for participating in the reverse e-auction (the “eligible Bidders”). Intimation shall be restricted only to the eligible Bidders. 

Provided also that in the event of identical initial price offers being submitted by two or more Technically eligible Bidders, all such Technically eligible Bidders shall be assigned the same rank for the purposes of determination of eligible bidders and in such case, the aforementioned fifty per cent shall stand enhanced to fifty per cent plus the number of Technically eligible Bidders, whose initial price offers are identical less the number of such identical initial price offers.
Illustration:
(i) In the event there are a total of ten Technically eligible Bidders, and each Technically eligible Bidders submits different initial price offer, then the Technically eligible Bidders holding the first fifty per cent of ranks (with any fraction rounded off to higher integer) or five whichever is higher shall be considered to be eligible Bidders.
(ii) In the aforementioned case, if three Technically eligible Bidders submit the same initial price offer and are ranked in first fifty per cent of the total number of ranks, then all the three Technically eligible Bidders shall be considered to be eligible Bidders and the total number of eligible Bidders shall stand increased by two. NAFED is not obliged to provide any explanation or clarification on their disqualification to Bidders who fail to qualify as Technically eligible Bidders.

Reverse e-auction

In Case of a Tie in L-1 Prices, the tender shall be followed by reverse auction among eligible bidders:

In the reverse e-auction, the eligible Bidders may submit their final price offers which shall be a lower than the Floor Price. The Final Price Offer may be revised till the conclusion of the e-auction.
(b) The e-auction process shall be annulled if none of the eligible Bidders submits a Final Price Offer on the reverse e-auction. In case the e-auction process is annulled due to non-submission of at least one Final Price Offer on the electronic auction platform, the Bid Security of the eligible Bidder(s) who has submitted the lowest Initial Price Offer in the e-tender mentioned above shall be forfeited in accordance.

(c) The eligible Bidder who submits the lowest Final Price Offer shall be declared as the “L1 Bidder” immediately on conclusion of the e-auction.

Conduct of reverse e-auction

Reverse e-auction is the process of inviting binding Final Price Offer(s) from eligible Bidders through internet for the purpose of determination of the L1 Bidder. During this process, the eligible Bidder will be able to submit its Final Price Offer as many times as it wishes against the same Lot. The eligible Bidder will remain anonymous to other eligible Bidders participating in the electronic auction process as well as to e-auction platform provider/ NAFED. The eligible Bidder will be able to see the prevailing lowest Final Price Offer against the Lot but the name of the lowest Qualified Bidder at any point of time will not be displayed. The Qualified Bidder shall have to put its Final Price Offer lower and below the displayed lowest bid by a minimum increment of Rs 1 to become the Lowest Qualified - Bidder.

The electronic auction process will have a scheduled start and close time which will be displayed on screen. A eligible Bidder will be able to put its Final Price Offer after the start of bid time and till the close time of electronic auction. The current server time (IST) will also be displayed on the screen. In the event a Final Price Offer is received during the last 10 (Ten) minutes before the scheduled close time of electronic auction, the close time of electronic auction will be automatically extended by 10 (Ten) minutes from the last received bid time to give equal opportunity to all other Qualified Bidders. This process of auto extension will continue till no Final Price Offer is received during a period of 10 (Ten) minutes. For example, assuming that the initial scheduled close time for a particular electronic auction is 1:00 pm and a Final Price Offer is received at 12:55 pm, the scheduled close time shall be revised to 1:05 pm. Again if a Final Price Offer is received at 1:01 pm, the scheduled close time shall be revised to 1:11 pm and so on. In the event that no further Final Price Offer is received till 1:11 pm, the electronic auction will close at 1:11 pm. The revised close time will be displayed on screen and the Qualified Bidders are advised to keep refreshing its webpage to get the latest information. The above example is only illustrative and meant for explaining the e-auction process only. During the process of electronic auction, the Bidder shall be required to sign their bids with their respective digital signature certificate (DSC) and the use of which has been duly Authorized on behalf of the Bidder and which was used at the time of registration. Any digital signature certificate other than the above shall not be acceptable for bid submission by the system. Bidders in their own interest are advised to get themselves acquainted with the electronic auction process of e-auction platform provider by getting their Authorized Representative trained beforehand through some demo electronic auctions.

3. Detailed Terms and conditions of the BID
A.  Scope of supply:
1. New Light Weight 775 gms Jute Sacking Bags for packing 50kgs Mustard Seeds as per BIS Specification No IS 18161:2023 amended up to date (size 91 cms * 67.50 cms, Weight 775 gms) for packing of 50 kg of Mustard Seeds which should be fully fit and appropriate for filling of Oilseeds to be procured under PSS/PSF Scheme of Govt of India. There should be no spillage from the filled bag during the normal handling/ transit etc. (3 blue stripes)

Note: BIS test methods shall be applicable as per BIS Specification No IS 18161:2023
1. 3 Ply Heracles stitches are mandatory for Light Weight Jute Sacking Bags (775 gms) bags.
2. Three blue stripes should be present in each and every bags.
3. Safety Stitches shall be provided at the inner edges of herakle stitches.
4. Transportation for supply of gunny bags to various State Level Agencies/State Civil Supply Corporation etc. has to be arranged by the Manufacturers/Millers or Authorized distributor/ dealer or traders
5. JC empanelled inspection agencies will be appointed by NAFED, and inspection will be carried out by different agencies on rotations basis

B. Quantity & Branding:

Bulk quantity of new light weight sacking jute bags 775 gms may be required for onward dispatches to various State Marketing Federations/State Level Agency etc. for packing of Oilseeds to be procured under PSS/PSF Scheme of Govt of India. The orders will be issued to the concerned Manufacturers/Millers or Authorized distributor/ dealer or traders of Jute bags as & when required by NAFED during the tenure of e-tender i.e. 45 days from the date of opening of financial bids under e-tender and the same has to be supplied by the respective Manufacturers/Millers or Authorized distributor/ dealer or traders.

Bags must be manufactured from Indian raw jute only. Imported Jute bags, jute bags manufactured with imported raw jute or jute yarn or fabric, unbranded or incompletely branded or wrongly branded jute bags or jute bags which do not conform to the BIS Standards should not be supplied by the Manufacturers/Millers or Authorized distributor/ dealer or traders and undertaking for the same must be submitted by bidder. Jute bags should be strictly marked with “Manufactured in India” as per the Gazette notification of Ministry of Textiles vide notification dated 15.01.2020 under reference no. S.O. 533(E) which shall be applicable to our tender terms and conditions. 

Further, following should be printed in each and every Light Weight Sacking Jute bags 775 gms bags supplied to various SLAs against NAFED work order:

· The mill name along with three stripes. 
· NAFED’s logo should be printed in each and every gunny bags.
· Branding may be different as per the consignee requirement and the same will be intimated while issuance of work order.

The quantity mentioned in the work order to the successful bidder would be purely indicative and not guaranteed and quantity can be decreased/ increased/ cancelled by NAFED, at any time.
C. Delivery Period:

(i) The gunny bags are to be supplied strictly within the prescribed time period from the date of placement of work order for supply by NAFED.
          (ii) The Manufacturers/Millers or Authorized distributor/ dealer or traders should adhere to the terms & conditions of the tender and stick to the commitment for supply of ordered quantity to the consignees within the stipulated time period. Non-performing Manufacturers/Millers or Authorized distributor/ dealer or traders will be penalized with strict actions like imposition of financial penalty or blacklisting/debarring in participation of NAFED’s future tenders or as deemed fit by NAFED. Also, bidders who have not yet completed 75% supplies under contracts to be awarded under this tender shall not be eligible for participation in subsequent tender(s) to be invited by NAFED for RMS-2025. Further, suppliers who have not performed their contractual obligations within the prescribed time period as per work orders issued under our earlier tender dated 17.10.2024 shall be liable for rejection, decision of NAFED in this regard shall be final and binding for all purposes.
          (iii)  Bidders shall furnish to NAFED their maximum monthly supply capacity to NAFED along with the supply schedule to be dispatched every fortnight (Refer Annexure-III) to NAFED and the same should be executed accordingly. 
Failure to perform contractual obligations within specified period may attract cancellation of work orders and allotment of the same to the other suppliers as deemed fit by Nafed at risks & costs of delinquent supplier (Self declaration in this regard needs to be submitted).
(iv) Furthermore, in any case the supplier fails to deliver the Quantity of gunny bags as mentioned in tender contract/work order within the prescribed period, the EMD/SD is liable to be forfeited.
D. 	Rate quotation:

The bags are required to be delivered to consignee’s designated delivery point/centre by transportation and after duly checking the quality by reputed inspection agency. The basic rates per 100 bags F.O.R destination quoted shall be inclusive of branding charges, transit insurance of goods, statutory taxes, transit cost, inspection, loading & Unloading, supervision charges & NAFED administrative charges. Eligible supplier shall have to take transit insurance of the Gunny bags (110% of the good value) being sent to various consignees. Bill shall be raised by bidders in favour of consignee, all inclusive, at approved F.O.R rate. 
NAFED will raise a separate bill for administrative charges i.e., 1.50 % plus GST @ 18% on the Manufacturers/Millers or Authorized distributor/ dealer or traders for various consignees at a time for a particular crop season. 
Manufacturers/Millers or Authorized distributor/ dealer or traders having capacity for a supply of minimum quantity of 10 Lakh pcs (without any bifurcation) in total can submit their bids. NAFED Kolkata branch reserves the right to place the work order according to the requirement of Consignee. 
E.	e-Tender Fee:

e-Tender fees of Rs. 5900/- per form (Rs.5000/-+ GST @ 18 %) in the form of DD/ Pay Order in favour of “NAFED” payable at Kolkata or NEFT/RTGS in the Bank Account of NAFED shall have to be deposited in this office within the scheduled time i.e. before commencement of e-Tender in the M/s. MSTC portal, as mentioned in the Tender Notice. e-Tender without tender fees as referred above, shall not be accepted. However, MSME is exempted from submission of e-tender fee.
F.       E.M.D:
An EMD of Rs. 20,00,000/- (Twenty Lakh only) is to be deposited in the form of DD/ Pay order in favour of “NAFED” or NEFT/RTGS in the Bank Account of NAFED.


REFUND of EMD: 
The EMD of unsuccessful tenderer shall be refunded after final acceptance of tender of successful bidder. EMD so deposited shall not accrue any interest. Tender without EMD, shall be summarily rejected. However, MSME millers are exempted from submitting EMD with tender, but they need to submit valid MSME certificate, if any false claim /invalid documents are found during technical evaluation, then such bid will be summarily rejected.

Bank Details:

Name of the Bank: RBL BANK, Thappar house, Kolkata
Name of Beneficiary: NAFED Kolkata
AC NO: 309007294147
IFSC: RATN0000161

G.	E-Way bill :

Manufacturers/Millers or Authorized distributor/ dealer or traders have to submit E-Way bill alongwith consignment note. 

H.	Security Deposit:

The successful bidder has to deposit 10% of total contract value as Security deposit after adjusting the amount of EMD already deposited upon issuance of work order by NAFED in the form of DD/ Pay order in favour of “NAFED” or NEFT/RTGS in the Bank Account of NAFED. Such Security Deposit shall be refunded after successful execution of the order and consignee receipt stating satisfactory receipt of the entire indented quantity. If the supplier fails to supply the quantity as per work order & e-Tender conditions, the security deposit shall be liable to be forfeited, and the supplier may be blacklisted / penalized as per the decision of NAFED.  However, MSME will also have to deposit security amount of 10% of total contract value after adjusting with the EMD amount (if any).
I.	Inspection:
(i). The inspection of goods shall be carried out by the JC empanelled inspection house appointed by the NAFED to ascertain the quality of material primarily. Inspection will be carried out at a particular location for Indian Origin bags by different agencies on rotations basis. The Surveyor shall be appointed by NAFED on rotation basis upon receiving of email communication from supplier and surveyor charges shall be borne by the supplier.
(ii). No supplier can send the inspection challan directly to the surveyor. Suitable Penalty will be levied if the inspection challan is cancelled more than twice by any supplier without any valid reason to be submitted in writing.
(iii). The inspection shall be carried out before loading into trucks. The report of passed inspection so carried out shall form the part of dispatch intimation, in lack of which the consignment may be rejected.
 (iv). The loading should be done immediately after inspection and any such delays in loading may be intimated to NAFED within 24 hours with proper explanation.
J.	Payment term:
(i). 90% payment shall be  processed on the basis of  goods dispatched, out of the payment received from the consignee within 15 working days of submission of  bills to NAFED, Kolkata office along with supporting documents. Each bill submitted, in triplicate, (one original along with two duplicate copy) should have Proof of dispatch of goods i.e. clean transport Challan showing the stock movement, positive inspection report of surveyor, loading supervision report along with sign & stamp of the inspection agency, valid e-way bill, valid tax invoice, valid insurance copy of 110% coverage duly endorsed by Insurance company& warranty or undertaking of the dispatched goods. and other required documents by NAFED / Consignee .
All the above stated documents should bear seal/ stamp and signature of the concerned supplier along with the payment check list format provided by NAFED.
(ii). Balance 10% payment  shall be processed by NAFED after receipt of  claim, along with  receiving clean and legible original acknowledgement duly sealed & signed by authorized representative of the consignee, UTR  details along with date of remittance of  Administrative charges to NAFED, and with the other  documents mentioned in the checklist provided by NAFED. Deduction of TDS as per Income Tax/GST Act shall be done at consignee level, certificate shall be issued by consignee in favour of the miller jute mills/ under intimation to NAFED Kolkata.
NB. : No balance payment will be released on photocopy / scan copies of documents submitted by the Miller. Supplier to submit original LR copies, legible, duly signed & sealed by the concerned consignees
(iii). The statutory dues such as GST must be paid irrespective of any consignee where the gunny bags will be supplied & undertaking for the same must be submitted or else balance  payment won’t be released.
The 1.50 % administrative charges needs to be remitted by supplier to NAFED Kolkata before release of Security Deposit/Payment by NAFED and proof of payment must be submitted immediately to NAFED.
K.	Procedure for Evaluating the e-Tender:

1. Two rounds of evaluation will be carried out by NAFED i.e., technical evaluation and Financial Evaluation

All relevant documents mentioned here-in the Tender documents, Eligibility Criteria, (with Annexure-II) legible, duly signed & sealed, have to be submitted  through email at nafkol@nafed-india.com as well as in the MSTC portal up to 21/01/25 till 02:00 PM for verification by the committee member(s) and if any discrepancies found by the committee, then the bid shall be rejected, and further financial bid won't be considered.

2. Financial Bid: Upon clearance of technical bid, financial bids would be opened by M/s. MSTC. Any deviation in submitting bids as per our mentioned terms and conditions, the bids won’t be considered. F.O.R rates are to be filled in proper place of e-Tender portal conducted by M/s. MSTC. For the purpose of evaluation of bid, total rate per bag, exclusive of GST shall be considered whereas the payment shall be made as per the total rate per bag, inclusive of all taxes.

3. After opening of financial bids, NAFED may go for L1 F.O.R rate matching with L2, L3 and other participants through mail communication which will be facilitated by M/s. MSTC.

L.	Technical Eligibility Criteria

a. The bidder (Manufacturer/miller or authorised distributer/dealer or trader) should be registered under the proprietor firm/partnership firm/private ltd/public limited company or any legal entity instituted under Indian laws.
b. Bidder should submit Rs.20,00,000/- towards E.M.D. & Tender Fee of Rs. 5,900/- before the deadline.
c. The Bidder must have average annual Turnover of Minimum 50 crore for the last 3 Financial Years.
d. The bidder should have successfully supplied 50 kg New Jute Bags (B-TWILL, B-Twill, A-Twill & Hessian) to various Govt. Departments/ Pvt. Companies / Federations in the past. Copies of work order along with satisfactory Performance certificate or  any other proof are to be enclosed with the bid.
e. The bidder is required to submit documents (as applicable) viz. certified copy of the GSTN registration certificates, PAN cards, Excise Certificate, partnership deed in case of partnership firm, Memorandum & Article of Association in case of Registered Company, copy of Audited Annual accounts for the last year or like documents, or any other documents as required by NAFED during execution of supplies, as the case may be.
f. An undertaking to the effect that the bidder has not been debarred/ disqualified / suspended/blacklisted from making supplies by any SLA / Federation / Government Organization etc. on account of any valid reason shall be submitted along with the bid. The bid of bidder who has been so debarred/disqualified / suspended/blacklisted will not be considered for evaluation.
g. The bidder should follow BIS laid down specifications strictly and supply Jute Bags as per BIS Specification only. A Certificate to be submitted for the same by the Manufacturers/Millers or Authorized distributor/ dealer or traders.

M.    Validity of Offer:

Offer (BID) shall be valid for a period of 45 days from the date of opening of financial bid under e-Tender during which no escalation in the rates will be allowed. The supplier/bidder is bound to accept all supply orders released by NAFED within the stipulated validity of the tender period and should ensure the supplies are completed against the order placed by NAFED.

 PSS/PSF procurement volume usually remains high and subsequently bulk requirement of gunny bags is placed with NAFED which may not be feasible for lone L1 supplier to meet at times. In such cases when demand is beyond offered quantity of L1 bidder, it is necessary to allocate orders to other bidders at L1 rate. Therefore, in order to ensure smooth dispatches, NAFED will negotiate with L2, L3 and other bidders to supply the gunny bags as per e-Tender terms & conditions at L1 rate if they are interested to do so and accordingly work orders will be issued to both L1 and L1 matching parties at L1 F.O.R rate.		
N. Defaults

If the Supplier refuses or fails to make deliveries of the cargo conforming to the contracted specification within the time specified or to perform faithfully any contractual terms, the NAFED may, without prejudice to other rights of the NAFED resulting from breach of the contractual terms, by given written notice cancel or rescind the contract or terminate the right of the Supplier to proceed with any or all of the remaining part under the work order to be performed. Any loss/penalties to NAFED causing this, shall be borne and recovered from the supplier.
 

O. Risk Purchase

If the supplier fails to ship entire quantity of gunny bags within the stipulated time period for Delivery or Shipment, NAFED may at its sole discretion cancel the work order and procure the undelivered quantities from the open market at the risks and costs of the Supplier and the supplier shall be liable to bear the additional costs so incurred by NAFED.

P.        Indemnity:
The bidders shall indemnify NAFED and keep indemnified against any loss or damage, claims, compensation, penalty, fine, levies, etc. on account of slackness, deficiency, failure to observe any obligations under the contract, failure to comply with statutory/ mandatory provisions pertaining to the contract by the bidders in respect of the services provided etc, whatsoever.
Q.       Holiday Listing:
NAFED's policy for Holiday-Listing, which is available on the website of NAFED must be acceptable to the bidders. Notwithstanding anything contained in this e-tender is mutatis mutandis applies to this and in the event, the agency(s) while discharging its obligations under the Agreement or otherwise, come(s) within the ambit of the said policy, NAFED at its sole discretion reserves the right to suspend/discontinue dealings or take any curative measures with agency (s) in accordance with the policy in force.
R.       Integrity Pact (IP) 	Integrity Pact has to be signed by the Applicant as per Annexure-I.
S.       Applicable law, Jurisdiction and Dispute resolution.
1) This e-Tender documents and its terms and conditions shall be constituted and the legal relation between the parties hereto shall be determined and governed accordingly to the laws of Republic of India and only courts at High Court of Calcutta shall have the jurisdiction in all matters arising out of/touching and/or concerning this agreement and parties to this agreement agree to irrevocably submit to the exclusive jurisdiction of those courts for purposes of any such proceeding. The afore mentioned exclusive and irrevocable jurisdiction of aforesaid courts are irrespective of place of occurrence of any cause of action pertaining to any dispute between the parties.

2) All or any disputes arising out or touching upon or in relation to the terms of this agreement including the interpretation and validity of the terms thereof and the respective rights and obligation of the parties shall be settled amicably by mutual discussion falling which the same shall be settled through arbitration. The arbitration proceedings shall be governed by the Arbitration and Conciliation Act of 1996 (as amended up to date) or any other statutory amendments/ modification thereof for the time being in force. The venue of the arbitration shall be at New Delhi, India and language of Arbitration shall be English. In case of arbitration, the cost of Arbitration shall be beared by both parties equally. 

3) Nothing contained in this clause shall prevent the NAFED from seeking interim injunctive relief against the supplier in the Courts having jurisdiction over the parties.


















GENERAL TERMS AND CONDITIONS
1. The eligible bidder shall have to carefully study and understand the conditions, specification and technical requirement of the bags to be supplied. If bidder has any doubt about the meaning of any term, conditions or specification etc., then bidder should refer to the State Head, NAFED Kolkata and get clarification before participating e-Tender. 

2. Arrangement for transportation for supply of gunny bags to various State Civil Supply Corporation/ State Level Agencies etc as well as inspection of goods which is to be carried out by recognized inspection house has to be made by the Manufacturers/Millers or Authorized distributor/ dealer or traders.

3. GST and Clearance Certificate: No bidder, who is not registered under the GST Act prevalent in the State, where his business is located, shall participate in e-Tender. The GST No. should be quoted and a GST Certificate from the commercial tax officer of the circle concerned shall be submitted along with the certified copy of Registration Certificate, without which the e-Tender may not be considered.

The e-Tenderer shall not sublet the supply awarded to it.

4. In case the supply of the material is found to be sub-standard or not as per the norms/ specification, it shall be rejected and the PO shall be cancelled by forfeiting EMD/ Security, which shall be acceptable to successful bidder.

5. At the time of filling the e-Tender it is to be ensured by the e-Tenderer that each page has been signed by them, towards its acceptance of terms & conditions. 

6. NAFED reserves the right to accept or reject any or all applications without assigning any reason thereof. The issue of this e-Tender document does not in any way commit or otherwise obliges NAFED to proceed with all or any part of e-Tender process. The e-Tender is not the subject of any process of contract or any contractual obligations between NAFED and prospective suppliers.

7. If the successful e-Tenderer fails to supply the material, NAFED shall be at liberty to arrange the same either by inviting fresh e-Tenders or by any other alternative means, at the risk and cost of the successful e-Tenderer. 

8. In case, the supply is delayed due to some reason or the other beyond the stipulated delivery period, the liquidated damages for delay shall be imposed, that shall be acceptable to successful bidder.

9. LIQUIDATED DAMAGES/ PENALTY:
NAFED reserve the right to levy penalty @ 1% plus GST of total value of balance jute bags per day of delay beyond the scheduled delivery date and is subject to maximum penalty of 10% plus GST of the total contract value due to delay in supply. Any such penalty shall be recovered from the bill amount & from the security deposit amount of the successful bidder. If the balance jute bags supply are delayed beyond 10 days from the scheduled delivery date, then the contracts will automatically stands cancelled.
a.) If the supplier requires extension in time in completion of contractual supply on account of occurrence of any hindrance, he shall apply in writing to the authority, which has placed the supply order, for the same immediately on occurrence of the hindrance but not after the stipulated date of completion of supply.

b.) Delivery period may be extended with or without liquidated damages if the delay in supply of goods is on account of hindrances beyond the control of the e-Tenderer or any force majeure measure reasons.

10. In case the supply of material is found substandard or not as per the norms, the supplier will lift the stock at its own cost within 7 days from intimation by NAFED. The rejected bags will lie at the risk and cost of the supplier with purchaser. Losses incurred in this process shall be in supplier account only. 

11. If any e-Tenderer imposes condition(s), which is in addition to or in conflict with the conditions mentioned herein, his e-Tender is liable to be summarily rejected. In any case none of such conditions will be deemed to have been accepted unless specifically mentioned in the letter of acceptance of e-Tender issued by consignee /NAFED.

12. NAFED, reserves the right to accept, reject or modify any or all e-Tenders partially or fully without assigning any reason thereof. The quantity of supply as mentioned above may be revised as per requirement.

13. NAFED will depute its representative for inspection of material at e-Tenderer’s site prior to its dispatch for which the e-Tenderer should have no objection.

14. The dispatch is time bound nature for which work orders will be issued to L1/ L1 matching Manufacturers/Millers or Authorized distributor/ dealer or traders based on their dispatch performances and at sole discretion of NAFED.

15. The sole discretion lies with NAFED for allocation of quantity to L1 and L1 matching Manufacturers/Millers or Authorized distributor/ dealer or traders simultaneously.

16. The settlement of administrative charges should be cleared by different eligible Manufacturers/Millers or Authorized distributor/ dealer or traders before releasing of payment/ Security deposit as per our tender terms & conditions. Proof of same to be submitted with their payment claim.

17. The EMD and SD amount will be released after receipt of clean and consolidated acknowledgement from respective SLAs of acceptance of goods.  
18. Supplier shall comply with applicable laws (if applicable) such as GST, TDS, Income Tax, PF & ESI etc.

19. FORCE MAJEURE-
(i) 	If at any time during the existence of this tender document, if the performance of all or part of its obligations is suspended by one of the parties by an event of Force Majeure, the other party may like-wise suspend the performance of all or part of its obligations hereunder, except for payment of any amount already due and payable on that day.
(ii)	Force Majeure shall include unpredictable, unforeseen, catastrophic and natural calamities or acts of God, such as earth quake, flood, land slide, epidemic, pandemic, drought, hail storm, high variation in temperature, fire, war, curfew, riots beyond the control of both the parties, existing on or after the effective date of this agreement, and not brought about at the instance of the party claiming to be affected by such event or which, if anticipated or foreseeable, could not be avoided or provided for and which has caused the non- performance or delay in performances, which prevent totally or partially the fulfilment of the obligations of one or both the parties.
 (iii)	The party invoking Force Majeure shall provide to the other party confirmation of the existence of facts constituting Force Majeure. Such evidence shall consist of a statement of certificate of Governmental Department or Agency. If such a statement of certificate could not be obtained by the party claiming Force Majeure, the affected party may, as a substitute therefore, make a notional statement describing in detail the facts claimed to constitute Force Majeure and the reasons, why such a certificate or statement confirming the existence of such facts could not reasonably be obtained. Non-availability of raw material will not be an excuse to the successful bidder for not performing their obligation under the contract.














      Ref:										 Date:
To
State Head
NAFED
Kolkata

Sub:  Submission of offer for supply of New light Weight  (Indian Origin-775   gms) Jute Sacking  bags for packing of  Mustard Seeds–reg.
With reference to your advertisement appeared on________in _________for purchase of New light weight Jute Sacking Bags 775 gms, we are submitting our offer, and agree as under:
1. We are submitting this offer (Proposal) on our own.
2. We agree to abide by the terms and conditions of the e-Tender.
3. We agree to abide this offer for a period of 45 days from the date of opening of e-tender _______ fixed for submitting the same and it shall remain binding upon us and may be accepted at any time before the expiry of that period.
4. Memorandum of Agreement (MoA) & Article of Association (AoA) 
5. Nature of Firm
6. We understand that NAFED is not bound to accept any or all offer it may receive.
7. It will be at the sole discretion of NAFED to amend or  reject the work order issued  
8. We are enclosing the following :
i. We enclosed herewith P.O./DD/UTR No.__________ dated _______ drawn on ..........................,............( Bank Name) for Rs. ___________/- ( Rupees ___________) on account of Earnest Money Deposit, as per terms and condition of offer.
ii. Attested copy of PAN / TIN No./GST No. of the firm / company.
iii. Letter of Authority issued by Firm / Company in favour of the person signing the documents.
iv. Brief profile of the establishment. 

Signature
Name		:
Designation  	:
Seal /Rubber Stamp of the Firm / Company:



( To be uploaded on letter head of Party in the M/s. MSTC portal )
E-TENDER FORM

E-Tender Form = Rs._______ 				E-Tender Form No. …
(Non-refundable)
         Ref:								Date:

To
       State Head, 

Sub:  Submission of offer for supply of New light Weight  (Indian Origin-775 gms) Jute Sacking  bags for packing of  Mustard seeds  .
Dear Sir,
	With reference to your advertisement appeared on________in _________for purchase of new light weight sacking jute bags 775 gms, we are submitting our offer, and agree as under:-
Name of the Bidder: .................................................................................

Name of Proprietor/ Director:

Contact Details:

Address:


Name of the authorized representative        .................................................................................

Scope of services :

Contact details : 










Rate = F.O.R Rate  
Quantity in Lakhs
(Bids to be submitted online in the MSTC e-Portal)

	Sl. No
	Gunny Bags
	Qty. to be supplied (No. of bags)
	F.O.R. rate with loading (per 100 bags) 
	F.O.R. rate with loading (per 100 bags) 

	
	
	
	Before Tax
	inclusive all taxes

	 
	 
	Indian Origin Light Weight Sacking Jute Bags-775 gms

	
	
	

	1
	Gujrat -GSCSC
	 
 
 
 
 
	 
	 

	2
	Rajasthan- RAJFED
	
	 
	 

	3
	Madhya Pradesh
	
	 
	 

	4
	Uttar Pradesh
	
	 
	 

	5
	Odisha
	
	 
	 

	6
	Telangana
	
	
	

	7
	Karnataka
	
	
	

	8
	Andhra Pradesh
	
	
	

	9
	Haryana
	
	
	

	10
	Punjab
	
	
	

	11
	Assam
	
	
	


	
Enclosed please find herewith P.O./DD/CHEQUE NO./UTRNo.__________ dated _______ drawn on .....................................
(Bank Name) for Rs. 5000/- (Rupees Five Thousand only) + GST @ 18% towards cost of e-Tender Form.

Thanking you,                                                                                      
                                         Yours faithfully,
                                                                                     Name:
                                    Designation:
                                                                                    Seal / Rubber Stamp of the Firm/ Company

Annexure- I
INTEGRITY PACT
National Agricultural Cooperative Marketing Federation of India Ltd. (NAFED), an apex level Co-operative Marketing Federation, registered under the provisions of Multi State Cooperative Societies Act, 2002 (as amended up to date), having its Head Office at Nafed House, Siddhartha Enclave, Ashram Chowk, New Delhi-110014 through ................. (hereinafter referred to as the “The Principal”, as the context may require or admit, which expression shall, unless excluded by or repugnant to the subject or context or meaning thereof, be deemed to mean and include its representatives, nominees, affiliates, successors and permitted assigns) of the ONE PART And a Proprietorship firm or a Cooperative organization or a Partnership firm duly registered under the provisions of Indian Partnership Act of 1932 or a Company registered under the relevant provisions of Companies Act of 1956 or 2013 (In case of Partnership Firm, the intending bidders shall submit a self-attested copy of partnership deed along with authorization in favour of signatory of the bidder documents, while in case of a Company, the Intending Bidder shall submit Certificate of Incorporation, Memorandum of Articles of Association and a Board Resolution in favour of authorized signatory, duly certified by a Company Secretary) through its Director/Partner/Proprietor Mr./Mrs. ___________________ and having its registered office at___________ (hereinafter referred to as "Vendor/Bidder/Contractor") which expression shall, unless repugnant or contrary to the context or meaning thereof, be deemed to mean and include its successors, authorized signatories and permitted assigns) of the OTHER PART
PREAMBLE
A. The Principal intends to award, under laid down organizational procedures, contract/s for …………………………………….. The Principal values full compliance with all relevant laws of the land, rules, regulations, economic use of resources and of fairness/transparency in its relations with its Bidder(s) and/or Contractor (s).

B. In order to achieve these goals, the Principal will appoint Independent External Monitors (IEMs) to monitor the tender process and the execution of the contract with the bidders/contractors/vendors for compliance with the principles mentioned in this Integrity Pact.
Article 1 – Commitments of the Principal
1. The Principal commits itself to take all measures necessary to prevent corruption and to observe the following principles:-

a) No employee of the Principal, personally or through family members, will in connection with the tender for, or the execution of a contract, demand; take a promise for or accept, for self or third person, any material or immaterial benefit which the person is not legally entitled to.

b) The Principal will, during the tender process treat all Bidder (s) with equity and reason. The Principal will in particular, before and during the tender process, provide to all Bidder(s) the same information and will not provide to any Bidder(s) confidential/additional information through which the Bidder(s) could obtain an unfair advantage in relation to the tender process or the contract execution.

c) The Principal will exclude from the process all known prejudiced persons.

2. If the Principal obtains information on the conduct of any of its employees which is a criminal offence under the IPC/PC Act, or if there be a substantive suspicion in this regard, the Principal will inform the Chief Vigilance Officer and in addition can initiate disciplinary actions.
Article 2 – Commitments of the bidder (s) / Contractor(s)
1. [bookmark: gjdgxs]The Bidder(s)/Contractor(s)/Vendor(s) commit themselves to take all measures necessary to prevent corruption. The Bidder(s)/Contractor(s) /Vendor(s) commit themselves to observe the following principles while participating in the tender process and during the contract execution.

a) The Bidder(s)/Contractor(s)/Vendor(s) will not, directly or through any other person or firm, offer, promise or give to any of the Principal’s employees involved in the tender process or the execution of the contract or to any third person any material or other benefit which he/she is not legally entitled to, in order to obtain in exchange any advantage of any kind whatsoever during the tender process or during the execution of the contract.

b) The Bidder(s)/Contractor(s)/Vendor(s) will not enter with other Bidders into any undisclosed agreements or understanding, whether formal or informal. This applies in particular to prices, specifications, certifications, subsidiary contracts, submission or non-submission of bids or any other actions to restrict competitiveness or to introduce cartelisation in the bidding process.

c) The Bidder(s)/Contractor(s)/Vendor(s) will not commit any offence under the relevant IPC/PC Act; further the Bidder(s)/Contractor(s) will not use improperly, for purposes of competition or personal gain, or pass on to others, any information or document provided by the Principal as part of the business relationship, regarding plans, technical proposals and business details, including information contained or transmitted electronically.

d) The Bidder(s)/Contractor(s)/Vendor(s) of foreign origin shall disclose the name and address of the Agents/representatives in India, if any. Similarly the Bidder(s)/Contractor(s) of Indian Nationality shall furnish the name and address of the foreign principals, if any. Further details of Indian Agents of Foreign Millers shall be disclosed by the Bidder(s)/Contractor(s)/Vendors. Further, all the payments made to the Indian agent/representative have to be in Indian Rupees only.

e) The Bidder(s)/Contractor(s)/Vendor(s) while presenting their bid, will disclose any and all payments made, are committed to or intend to make to agents, brokers or any other intermediaries in connection with the award of the contract.

f) Bidder(s)/Contractor(s)/ Vendor(s) who have signed the Integrity Pact shall not approach the Courts while representing the matter to IEMs and shall wait for their decision in the matter.

2. The Bidder(s)/Contractor(s)/Vendor(s) will not instigate their persons to commit offences outlined above or be an accessory to such offences.

Article: 3 – Disqualification from tender process and exclusion from future contracts

If the Bidder(s)/Contractor(s)/Vendor(s), before award or during execution has committed a transgression through a violation of Article 2, above or in any other form such as to put their reliability or credibility in question, the Principal is entitled to disqualify the Bidder(s)/Contractor(s) from the tender process or take action as per the laid down procedure.
Article: 4 – Compensation for Damages
1. If the Principal has disqualified the Bidder(s) from the tender process prior to the award according to Article 3, the Principal is entitled to demand and recover the damages equivalent to Earnest Money Deposit/Bid Security.

2. [bookmark: 30j0zll]If the Principal has terminated the contract according to Article 3, or if the Principal is entitled to terminate the contract according to Article 3, the Principal shall be entitled to demand and recover from the Contractor/vendor liquidated damages of the Contract value or the amount equivalent to Performance Bank Guarantee.
Article: 5 – Previous transgression
1. The Bidder declares that no previous transgressions occurred in the last three years with any other firm/Company/organization in any country conforming to the anti-corruption approach or with any Public Sector Enterprise in India that could justify its exclusion from the tender process.

2. If the Bidder makes incorrect statement on this subject, he can be disqualified from the tender process or action can be taken as per the procedure mentioned in “Guidelines on Banking of business dealings”.
Article: 6-Equal treatment of all Bidders / Contractors /Subcontractors
1. In case of Sub-contracting, the Principal Contractor shall take the responsibility of the adoption of Integrity Pact by the Subcontractor.

2. The principal will enter into agreements with identical conditions as this one with all Bidders and Contractors.

3. The Principal will disqualify from the tender process all bidders who do not sign this Pact or violate its provisions.

Article: 7 - Criminal charges against violating Bidder(s) / Contractor(s) / Subcontractor(s) If the Principal obtains knowledge of conduct of a Bidder, Contractor or subcontractor, or if an employee or a representative or an associate of a Bidder, Contractor or Subcontractor which constitutes corruption, or if the Principal has substantive suspicion in this regard, the Principal will inform the same to the Chief Vigilance Officer.
Article: 8 - Independent External Monitor

1. The Principal appoints competent and credible Independent External Monitor for this Pact after approval by Central Vigilance Commission. The task of the Monitor is to review independently and objectively, whether and to what extent the parties comply with the obligations under this Integrity Pact.

2. The Monitor is not subject to instructions by the representatives of the parties and performs his/her functions neutrally and independently. The Monitor would have access to all Contract documents, whenever required. It will be obligatory to him /her to treat the information and documents of the Bidders / Contractors as confidential. He /she will report to the Managing Director, Nafed.

3. The Bidder(s)/ Contractor(s) accepts that the Monitor has the right to access without restriction to all Project documentation of the Principal including that provided by the Contractor will also grant the Monitor, upon his/her request and demonstration of a valid interest, unrestricted and unconditional access to their project documentation. The same is also applicable to Sub- contractors.

4. The Monitor is under contractual obligation to treat the information and documents of the Bidder(s)/ Sub-contractor(s) with confidentiality. The Monitor has also signed declarations on ‘Non- Disclosure of confidential Information’ and of ‘Absence of Conflict of interest ‘. In case of any conflict of interest arising out at a later date, IEM shall inform the Managing Director, Nafed and recues himself/herself from that case.

5. [bookmark: 1fob9te]The Principal will provide to the Monitor sufficient information about all the meetings among the parties related to the Project provided such meetings could have any impact on the contractual relations between the Principal and the Contractor. The parties offer to the Monitor the option to participate in such meetings.

6. As soon as the Monitor notices, or believes to notice, violation of this agreement, he/she will so inform the management to discontinue or take corrective action, or to take relevant action. The monitor can in this regard submit non-binding recommendations. Beyond this, the Monitor has no right to demand from the parties that they act in a specific manner, refrain from action or tolerate action.

7. The Monitor will submit a written report to the Managing Director, Nafed within 8 to 10 weeks from the date of reference or intimations to him by the Principal and, should the occasion arise, submit proposals for correcting problematic situations.

8. If the Monitor has reported to the Managing Director, Nafed, a substantiated suspicion of an offence under relevant IPC/PC Act, and the Managing Director, Nafed has not, within the reasonable time taken visible action to proceed against such offence or reported it to the Chief Vigilance Officer, the Monitor may also transmit this information directly to the Central Vigilance Commissioners.

9. The word “Monitor” would include both singular and plural.
Article 9 – Pact duration
1. This pact begins when both parties have legally signed it. It expires for the Contractor 12 months after the last payment under the contract, and for all other Bidders 6 months after the contract has been awarded. Any violation of the same would entail disqualification of the bidders and exclusion from future business dealings.

2. If any claim is made/lodged during this time, the same shall be binding and continue to be valid despite the lapse of this pact as specified above, unless it is discharged/determined by the Managing Director, Nafed.

Article 10 : Other Provisions
1. This agreement is subject to Indian Law. Place of performance and jurisdiction is the Registered Office of the Principal, i.e. New Delhi.

2. Changes and supplements as well as termination notices need to be made in writing.

3. If the bidder is a partnership or a consortium, this agreement must be signed by all partners or consortium members.

4. Should one or several provisions of this Integrity Pact turn out to be invalid, the remainder of this agreement remains valid. In this case, the parties will strive to come to an agreement to their original intentions.

5. Issues like Warranty/Guarantee etc. shall be outside the purview of IEMs.

6. In the event of any contradiction between the Integrity Pact and its Annexure, the Clause in the Integrity Pact will prevail.


I 
(For & on behalf of the Principal)				(For & on behalf of bidder/Contractor)
(Office Seal)							 (Office Seal)
Place: 	_ 
Date 	_ 
Witness 1: 
(Name & Address) 	
Witness 2: 
(Name & Address) 





Annexure-II
Details Required to be submitted for technical Evaluation
A.	AUTHENTICATION OF BIDDER PROFILE

1.	Name of Bidder:
2.	(a)	Registered Address with Contact No. & E-mail ID:
(b)	Factory/Godown Address with Contact No. & E-mail ID:
· The supplier be the Individuals, Proprietary or partnership firms, registered companies or any other legal entities having arrangements for New Jute Bags for packing of Pulses & Oilseeds shall only be eligible to participate in the tender.

4.	Constitution of Bidder:
Proprietorship / Partnership / Limited Liability Partnership / Private Limited / Public Limited / Society/ Others:

5.	Company Identification Number (CIN) / Udyog Aadhar No. (if not proprietary firm)/: Aadhar No. (Proprietor) and Director’s Identification Number (DIN) of all Directors of the Bidder:
6.	Date of Incorporation	:
7.	PAN Number	:
8.	GST Number                                                        :
9.	Years of Business Experience in dealing with Government Organizations:
10.		Details of Orders (Item & Value wise) received annually in descending order value and whether executed successfully (year-wise):
(A)  From Different Organizations/ Departments:

	S. No.
	Year (2021-22, 22-23, 23-24)
	Ordering Organization/ Deptt. Agency
	Item Name
	Quantity
	Order Value
	Status	of Execution* /          Non-execution

	1.
	
	
	
	
	
	

	2.
	
	
	
	
	
	

	3.
	
	
	
	
	
	



      *Execution means final delivery and acceptance of Goods/Services or receipt of payment.  
*Bidder to submit a satisfactory performance certificate from consignee, (besides NAFED order).

12.	Whether the item is covered under Memorandum and Article of Association of Firm: Yes / No
13.	 Whether the Firm is Debarred / Blacklisted by any SLA/ Federation / Government Organization, a non-conviction certificate be submitted on company’s letter head duly signed by Proprietor / Partner: 
14:    Whether the firm is having Export & Import license: If yes, kindly submit during the time of registration.
15.   	The bidder should supply Jute Bags as per BIS Specification. A Declaration / Certificate to be submitted for the same by the bidder.
16.    The Bidder must have average annual Turnover of at least 50 crores for the last 3 Financial Years.
17. The DECLARATIONS AND UNDERTAKING” are as under –
i.	It shall be incumbent upon all applicants/intending bidders to submit following declarations on the letter head of their entity(ies) while submitting their applications:
a) The intending bidder(s)/applicant(s) is/are/was/were neither in litigation with Nafed at any point of time regarding any business and trade activity of Nafed nor was/were it/they ever blacklisted by Nafed on account of such litigation(s) or otherwise.
b) Any of the present and past directors/proprietor/partners/ promoters etc of intending bidder(s)/applicant(s) was/were or is/are not part of such other and separate entity(ies) which was/were/is/are in litigation with Nafed in present or past or/and such other entity (ies) has/have/had ever been blacklisted by Nafed in the past for any reason.
ii.	If intending bidder(s)/applicant(s) is/are/was/were in litigation (s) with Nafed in present/past, it shall be incumbent upon such bidder(s)/applicant(s) to furnish the details of such litigation(s) and consequent blacklisting, if any, on the letter head of the entity (ies). In such scenario, the declaration as mandated above at (a& b) shall not be required.
iii.	If any of the applicant(s) /intending bidder(s) or their promoters are found involved in litigation(s) with Nafed whether in past and present or they have/had been blacklisted by Nafed or/and any of the promoters of intending applicant(s)/bidder(s) was/were part of the management of such other and separate entity(ies) which was/were/ is/are in litigation(s) with Nafed in present or past or/and such other entity (ies) has/have/had ever been blacklisted by Nafed in the past for any reason, Nafed shall have sole discretion to decide on the selection of such applicant(s)/bidder(s) even if such applicant(s)/bidder(s) fulfilling eligibility criteria and Nafed's decision either to select or reject such applicants/bidders shall be final and binding and no further communication/grievance against such decision shall be entertained in this regard.
B.	FINANCIAL CAPACITY:
1.	Annual Audited Turnover of the Company with Profit / Loss Statement of last three years duly certified by Charted Accountant:
	S. No.
	Financial year
	Turnover in Rs. (In Lakhs)
	Profit or Loss Figure (in Lakhs)
	Profit/loss Amount (In Lakhs)
	Whether Audited

	i)
	
	
	
	
	

	ii)
	
	
	
	
	

	iii)
	
	
	
	
	



(Sign by Authorized Signatory)
Name of Bidder  
                      Name of Authorized signatory -  
  Designation 
        Contact number  
     Authorized by 








Annexure-III
Supply Schedule of Light Weight Sacking Jute Bags 775 gms to be dispatched every fortnight
	Supplier Name
	Supply Schedule

	
	Schedule of quantity of gunny bags to be dispatched every fortnight







--------------End of Document-------------
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NATIONAL AGRICULTURAL COOPERATIVE MARKETING FEDERATION OF INDIA LTD.
12C, LORD SINHA ROAD, SHYAM KUNJ SOCIETY, BLOCK-E & F, 2nd FLOOR, KOLKATA-700071
Tel- 033-46054177. E-mail- nafkol@nafed-india.com; nafedkolkata@gmail.com , Web:- www.nafed-india.com; Twitter: @nafedindia
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